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Siapa yang tidak kenal Adobe Photoshop?? Sebuah aplikasi grafis terkenal seantero dunia 

buatan kakak-beradik Thomas dan John Knoll. Setidaknya sudah ada 13 kali release versi 

Photoshop. Dari sejak tahun 1987 sampai dengan April 2012, saat ini sudah mencari versi 13 

atau disebut juga CS 6.  

 

Gbr. Release Photoshop 

Lisensi Dokumen: 
Copyright © 2003-2007 IlmuKomputer.Com 

Seluruh dokumen di IlmuKomputer.Com dapat digunakan, dimodifikasi dan disebarkan secara 

bebas untuk tujuan bukan komersial (nonprofit), dengan syarat tidak menghapus atau merubah 

atribut penulis dan pernyataan copyright yang disertakan dalam setiap dokumen. Tidak 

diperbolehkan melakukan penulisan ulang, kecuali mendapatkan ijin terlebih dahulu dari 

IlmuKomputer.Com. 
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Dibanding versi 12 atau CS 5 didalam Photoshop  CS6,  kita akan menemukan 27 Fitur baru. 

Berikut 27 Fitur Yang terdapat di Photoshop CS6 

1. Anda Dapat Mengubah Warna Tampilan Pada Photoshop  

Untuk Merubah tampilan pada Photoshop CS6 ini Anda tinggal  menekan 

Shift+F1(untuk Memberikan Warna Lebih Gelap Pada Tampilan dan Shift+ F2 untuk 

memberikan Warna lebih terang. 

 
 Keempat Warna Baru Pada tampilan Photoshop CS6 
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Anda dapat mengatur Warna Tampilan di dalam menu Preferences, (Menu Edit / 

Preferences / Interface) disana anda akan menumukan pengaturan secara manual, dan 

anda dapat memilih warna tampilan yang anda sukai. 

 

2. Bagaimana Kita Dapat Menyimpan Hasil Kerja kita secara Otomatis. 

 

 

 
 

Seringakali di saat kita sedang memulai suatu pekerjaan dalam Program Photoshop, 

kadang kita mengalami masalah di saat kita sedang bekerja, tiba tiba program tersebut 

menjadi Crash atau eror. sehingga apa yang sudah kita buat menjadi hilang dan tidak 

tersimpan, dalam Photoshop CS6 Anda dapat melakukan setingga untuk membuat 

Photoshop CS6 ini dapat menyimpan secara otomatis setiap 5 menit sampai dengan  60 

menit, sehingga Anda dapat menemukan kembali Pekerjaan yang telah anda buat pada 

terakhir kali sebelum Program Photoshop CS6 ini mengalami masalah. 

 

 
 

Bahkan kelebihan dari Photoshop CS6 ini dapat menyimpan File Sebesar apapun secara 

otomatis dalam waktu yang bersamaan di saat anda sedang bekerja, tanpa mengangu 

perkerjaan Anda sedikitpun 
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Akan ada sebuah Bar yang muncul di saat Photoshop akan menyimpan suatu File yang 

sangat besar 

 

 

3. Dalam Photoshop CS6 ini Anda dapat derngan mudah mencari Sebuah Layer di 

dalam 100 Layer yang Anda buat 

 

Seringkali waktu kikta terbuang hanya dengan mencari sebuah layer yang kita 

inginkan, tanpa kita sadari layer yang ada sudah mencapai ratusan, sehingga kita 

dibuatnya menjadi pusing.  
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Tapi dalam Photoshop CS6 ini Anda tidak perlu lagi kuatir karena Anda tinggal 

mengaktifkan Filtering off, Anda cukup tekan di dekat bagian atas kanan palet. 

sehingga sekarang Anda tidap perlu lagi pusing atau sakit kepala, karena sekalipun anda 

bekerja di dalam layer yang sangat banyak, Anda akan dengan mudah menemukannya 

tanpa membuang waktu Anda 

 

 

4. Mengedit beberapa Layer Kapanpun Anda inginkan 

 

Photoshop CS6 sudah mengalami beberapa perbaikan dan bahkan menambahkan 

beberapa perangkat tambahan, sehingga Anda dapat mengedit beberapa Layer 

pada suatu waktu. Pertama-tama anda dapat menekan Ctrl + J untuk Menduplikasi 

beberapa layer hotkey. Anda juga dapat membuat mode blending, mode 

penguncian, Opacity dan memberikan label warna pada setial layer kapanpun Anda 

inginkan. 
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5. Perbaikan pada Tool Magic Wand  

 

Sebelumnya, banyak pengguna Photoshop tidak tau kenapa Tool magig wand tidak 

dapat bekerja seperti yang mereka inginkan, di karenakan masih ada   bug apabila 

anda mengubah pengaturan ukuran sampel pada alat pipet Anda, ssehingga kita 

tidak dapat mengubah ukuran Magic Wand Tool kita, dalam hal ini Photoshop CS6 

sudah memperbaiki Fitur ini sehingga Anda dapat menemukan beberapa sampel 

ukuran yang ada pada Option Bar Magic Wand. 

 
 

6. Membuat Selesksi lebih baik 

Dalam Photoshop CS6 untuk mendeteksi Wajah dan warna kulit sudah menjadi lebih 

baik, hanya dengan mengatur mode untuk Kulit berwarna itu sudah dapat medeteksi 

wajah dari kulit tersebut, fitur ini sudah mnejadi cukup baik dalam photoshop CS6 ini 
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7. Dengan menggunakan Alat Crop Baru 

 

Crop Di CS6 ini memang bisa sedikit membigungkan ketika Anda pertama kali 

menggunakannya. Adobe mengambil alat Crop lightroom dan memasukannya ke 

dalam Photoshop. Pertama-tama, Secara otomatis Anda akan di berikan pilihan, dan 

Anda tinggal memilih Alat Crop mana yang Harus Anda gunakan sesuai dengan 

keperluan  
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Crop Di CS6 

Alat Crop baru ini menunjukan tampilan dan background Anda, Jika Anda bertujuan 

untuk memperluas area tanaman melampaui batas-batas gambar Anda. 

 

 
 

Anda dapat menekan tombol O untuk anda dapat mengunakan Fitur Crop ini 

 

 

Yang baru dari fitu Crop ini yaitu Anda dapat memotong gambar Anda secara Non-

destruktif, sehingga Anda dapat memperluas Crop Anda di lain waktu, jika Anda ingin 

menonaktifkan Fitur ini, Anda tinggal menonaktifkan tanda centang "Delete Cropped 

Pixels" pada bar. 
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Delete Cropped Pixels 

 Alat ini hanya bekerja bila Anda tidak memakainya pada text. 

  

 

 

 

8. Eyedrooper alat perangkat tambahan 

 

Mode sampel baru untuk alat Eyedrooper memungkinkan Anda mengabaikan 

peyesuaian lapisan dan sampel dari lapisan saat ini dan di bawah ini, juga ukuran 

sampel mengalami perubahan ukuran tanpa mempengaruhi Magic tool. 

 

  

Mode pengambilan sampel baru   

 

9. Menggunakan Patch Tool pada Content-Aware Mode 

 

Tool Patch ini bukanlah Tool baru  tetapi dalam mode Content Aware Tool ini bekerja 

lebbih baik untuk menghapus objek dan memilih area untuk menduplikat background . 

dangan mode Content Aware, 
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Anda dapat menentukan area yang mana saja yang mendapatkan duplikat sehingga 

pemindahan objek ke  

area tertentu menjadi lebih baik. 

 
 

Anda dapat mengubah/memilih mode Path di bagian Bar.    

 
 

 

 

10. Mengunakan Tool Content Aware memungkinkan Anda untuk memindahkan 

dan mempluas Objek dengan mudah 

 

Move Tool Content Aware memungkinkan Anda memindahkan Objek dengan mudah, 

Tool ini bekerja disaat kita mengerakan benda dalam Background yang sederhana tetapi 

Tool ini tidak dapat bekerja dengan sempurna Apabila Backgroundnya lebih Rumit 

seperti Contoh di bawah ini. 
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Move Tool Content Aware 

 

 

Mengunakan Move Tool Content Aware 

 
 

Hasil dari mengunakan Content Aware 

 
Photoshop melakukan sebagian besar pekerjaan dalam bentuk Klon atau diplikat 

dengan menyempurnahkan atau memperbaiki gambar seperti yang ada di bawah ini. 
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Mengubah pengaturan Adaptation 

 

Apabila tidak mendapatkan hasil yang lebih baik. coba sesuaikan Tingkat level dari 

Adaptation tersebut. 

 

Mengubah Mode dari pindah ke Perluas bahkan sekarang anda dapat memperpanjang 

objek. untuk menggunakannya cukup membuat pilihan pada objek kemudian tarik 

untuk memperpanjang Objek 

 

  

 Beralih ke Mode Extend 

 

 
 

11. Menggunakan Brush Tool yang di perbaharui 

 

Seorang Pelukis Digital selalu menyukai  apa bila ada Brush Tool  yang baru, 

Photoshop CS6 memperkenalkan dua fitur baru yaitu erodible tip and airbrush tip. 

Pengaturan kuas Erodible membiarkan Anda menarik garis dengan ujun yang 

mengikis seperti krayon (dari tipis ke garis tebal). ini lha yang memungkinkan Anda 

membuat lukisan yang terlihat lebih realistis. Tips airbrush harus di gunakan bukan 

dengan mouse tapi dengan pen tablet, karena pen tablet memungkinkan Anda 

mengunakannya seperti kita mengunakan airbrush - untuk mengunakannya kita 

harus menekannya lebih keras untuk membuat garis tipis atau ringan untuk garis 

tebal. Hal ini juga dapat mendeteksi sudut pena Anda untuk mengontrol arah 

semprotan. Anda akan membutuhkan sebuah tablet dengan sensitivitas yang tinggi 

untuk Fitur ini dapa bekerja dengan baik.  



 
 

Komunitas eLearning IlmuKomputer.Org 

Copyright © 2003-2013 IlmuKomputer.Org 
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Tool Brush sendiri telah diperbaiki dengan ukuran kuas masimal 5000px dan di dukung 

oleh berbagai macam kursor. Dengan dukungan berbagai macam kursor ini 

memungkinkan Anda mengubah ukuran dengan berbagai macam kuas hanya dengan 

menyeret mouse anda. 
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Jika Anda menggunakan Tool Erodible, Amda harus menetapkan Hotkey untuk 

mempertajam ujungnya, Caranya Anda dapat ke menu Edit> Alat ini terletak dibagian 

paling bawah dari daftar tools. 

 

 
Pengaturan Airbrush 
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Untuk meninjau sebuatu Brush, Anda dapat tahan tombol ALt/Optian lalu ke kanan 

setelah itu tarik dimana saja dalam lebar kerja anda untuk membuka pengaturan Brush 

Anda.  

 

12. Menggunakan Gradient  

 

Apakah Anda pernah memakai Tool Gradient , Anda akan melihat dan menyukai 

untuk Skala baru yang memungkinkan anda untuk mengatur skala hingga 1000% 

(sebelumnya hanya dampai dengan 150%) 

 
Skala Gradient naik menjadi 1000% dari sebelumnya 150% di CS5 
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13. Menggunakan Fitur Text Yang Baru 

 

Ada begitu banyak Fitur dengan Type Tool bahwa Photosshop CS6 sekarang 

memiliki Menu Jenis baru. Salah satu fitur yang sangat di cintai oleh desaigner yaitu 

Lorem Ipsum. Lorem Ipsum berguna untuk memberikan kepada Anda text secara 

Acak tanpa anda harus mengetik. Bahkan Anda dapat membuat sendiri Palet dengan 

karakter yang baru dalam firutr ini. 

 

 
Open Type kini dibangun ke dalam palet karakter, Dalam CS5 ini yang tersembunyi di 

dalam menu Flyout 
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Gunakan karakter baru untuk membuat text dan preset paragraf. 

 

 

 
Gaya Pilihan karakter 
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Besar Huruf Anda dapat mengubah ukuran preview Font dengan pergi ke Type > Font 

Preview Size menu. 

 

 

14. Membuat adjustments dengan Adjustments and Properties palettes 

 

Dalam Photosshop CS5, Anda akan mengubah pengaturan dalam Adjustments panel 

. Sedangkan dalam CS6 memiliki panel baru untuk Properties yang di sebut (Window 

> Properties). Di dalam panel Properties merupakan tab Masking baru dimana Anda 

dapat menyesuaikan Layer mask 
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Fitur Yang terbaru dalam CS6 juga dapat meningkatkan Brightness dan Contrast dan 

pengaturannya dapat dilakukan secara otomatis 



 
 

Komunitas eLearning IlmuKomputer.Org 

Copyright © 2003-2013 IlmuKomputer.Org 
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Ada tombol Auto baru dalam Brightness dan Contrast, sehingga Tingkat dan 

penyesuaian Curves dapat bekerja secara berbeda.Sebelumnya untuk untuk 

menyesuaikan Contrast Anda akan di bawa ke untuk menyesuaikannya ke bagian warna 

merah , hijau dan biru. Dalam Photoshop CS6 itu. Brightness dan Contrast dan warna 

yang dihasilan lebih stabil. dan juga lebih mudah untuk melakukan penyesuaian setelah 

itu Anda dapat memodifikasi titik hitam dan putih tanpa harus pergi ke setiap warna 

 

 

Perbandingan nya di CS6 untuk Brightness dan Contrast yaitu meningkatkan Brightness 

dan Contrast secara Otomatis dan menghasilkan warna yang lebih stabil 

 
auto adjustment yang baru dan dilakukan secara algoritma dalam CS6  

 

15. Warna Baru pada  Lookup Adjustment? 

 

Photoshop CS6 memiliki Adjustment Baru yang dapat di terapkan pada Foto 

kesayangan Anda, dan ini salah satu yang sangat di sukain oleh Photograper. 

Adjustment Color Baru ini dapat Anda terapkan pada untuk mensimulasikan warna 

Film, Monitor dan perangkat lainnya. Hal ini terlihat cukup teknis pada pandangan 

pertama tetapi ketika Anda kilk pada menu drop-down, Anda akan menemukan 

bahwa Photoshop cs6 ini di lengkapi dengan preset warna yang dapat dengan 

mudah di gunakan . 
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Color Lookup Adjustment 

 

Photoshop CS6 memiliki ini built preset dalam dan sekarang Anda bisa mendapatkan 

warna retro ini dengan hanya satu lapisan Adjustment. 

 
 

 

3 Jalur Teknic perbandingan Warna 
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Photoshop CS6 ini dilengkapi dengan 32  profil warna Looup dan kelebihannya Anda 

sendiri menabahkannya bahkan lebih banyak lagi. 

 

16. Mengedit File RAW di kamera baru  

 

Phothosshop CS6 menggunakan Kamera RAW yang sama yang dapat kita temukan 

di 4 Lightroom dan tentunya sekrang dapat bekerja menjadi lebih baik. Ada sebuat 

proses yang baru untuk mengatur gambar yang lebih masuk akal, dan Anda hanya 

memprosesnya dari atas ke bawah. Adjustment juga memberikan hasil yang lebih 

baik dan lebih banyak ruang untuk memulihkan sebuah Gambar  



 
 

Komunitas eLearning IlmuKomputer.Org 

Copyright © 2003-2013 IlmuKomputer.Org 

 
 

 

Camera RAW 7 VS 6.5 

Alur kerja baru ini memungkinkan Anda bekerja dari atas ke bawah, dan yang perlu 

Anda ketahui bahwa nilai-nilainya semua selalu di mulai dengan 0. 

 

Penyesuaian Camera RAW 6.5 VS 7 secara Otomatis 
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Camera RAW 7 melakukan penyesuain otomatis secara signifikan dan penyesuainnya 

bekerja lebihbaik dari pada RAW 6.5  

 

17. Memperbaiki Sudut lebar sebuah Foto dengan Filter Wide Angle terbaru. 

 

Photografer sekarang memiliki kontrol atas Foto mereka dengan filter baru yang 

dapat mengoreksi distorsi. Pertama ia dapat bekerja sebagai Smart Filter yang berarti 

Anda dapat mengubah lapisan Anda menjadi Smart Object, dan Anda dapat 

memakai Filter dan kemudian kembali untuk mengeditnya setiap saat bahwa dengan 

mengoreksi distorsi dapat dilakukan dengan mudah dan cepat. Cukup menarik garis 

lurus di atas Objek dan Photoshop secara otomatis akan memperbaiki Photo kita.  

 

Jika Anda membuat panorama dari beberapa foto dengan Photoshop, Anda dapat 

menggunakan opsi koreksi Panorama yang dirancang untuk memperbaiki 

lengkungan di photo panorama kita. Anda dapat menciptakan panorama dengan 

stitch tool Photoshop  dan Anda akan melihat hasilnya - Photoshop CS6 tidak 

menyerankan Anda untuk membuka file panorama dalam bentuk JPEG, karena File 

tersebut  tidak akan bekerja dalam Proses ini. 
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Menggunakan Adaptive Wide Angle filter 

Cukup menarik garis untuk meluruskan tepi. Tahan tombol Shift untuk membuat tepi 

yang sempurna secara horisontal atau vertikal. 

 

 

 
 

 

Sebelum dan sesudah koreksi dari perspektif dan distorsi dengan  Adaptive Wide Angle 

filter 

 

Filter ini bekerja baik untuk memperbaiki foto-ultra wide angle. Garis miring dan 

melengkung diluruskan dalam waktu kurang dari 1 menit. Hal ini juga tetap 

menghasilkan gambar yang perspektif. 

 

18. Menggunakan  Liquify tool pada gambar dengan ukuran besar. 
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Cukup banyak orang yang mengunakan  Liquify tool untuk Photo yang mereka 

hasilkan. Sekarang di CS6, Anda dapat mengubah gambar dengan tidak ketinggalan 

1 pun detail pun dari Photo Anda. Hal ini dimungkinkan dengan Engine Graphics 

baru Merkurius yang menggunakan GPU dapat melakukan pekerjaan tersebut. Anda 

bahkan dapat mengedit menggunakan ukuran maksimal dengan mengunakan new 

max brush dari 15.000 piksel (naik dari 1500 piksel) tanpa lag. 

 
 

Liquify Tool di Photoshop CS6 

Peningkatan kinerja dan ukuran brush yang lebih besar membuatnya lebih mudah untuk 

mengubah resolusi tinggi sebuah Photo. 
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Sebelum dan sesudah perbandingan menggunakan Liquify Tool sehingga 

menjadi  melengkung.  

Menggunakan ukuran brush yang lebih besar, Anda dapat membuat Photo Anda 

melengkung pada resolusi yang tinggi pada sebuah foto. 

 

19. Mengubah foto menjadi lukisan minyak dalam hitungan detik. 

 

Filter ini sangat artistik sehingga memungkinkan Anda dengan mudah mengubah 

foto menjadi lukisan minyak. Sayangnya, Filter ini mempunyai masalah yang sama 

seperti banyak filter artistik pada umumnya, Itu berarti bahwa jika Anda bekerja pada 

sebuah foto dalam ukuran resolusi yang tinggi, Anda mungkin tidak akan 

mendapatkan efek yang cukup kuat. Satu-satunya cara adalah menurunkan resolusi 

Photo Anda, Setelah Proses Selesai, baru kemudian Anda memperbesar kembali 

resolusi tersebut. 

 

Sebelum dan sesudah perbandingan menggunakan filter Cat Minyak (Oil Paintings) 

Mengubah foto ke lukisan minyak dalam hitungan detik. 
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Photoshop CS6  Filter Cat Minyak (Oil Paintings)  

Filter Cat Minyak (Oil Paintings) 

 

 

 

Diagram pengaturan Filter Cat Minyak (Oil Paintings)  

Pengaturan Anda dapat di sesuaikan untuk mendapatkan hasil tampilan yang Anda 

suka. 
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20. Selective blurring dengan Field Blur,  Iris Blur, dan Tilt-Shift 

 

Tool Selective blurring menjadi populer pada beberapa tahun terakhir ini dan 

Photoshop CS6 kali ini membuat tool ini menjadi lebih baik. sehingga membuat kita 

menjadi lebih mudah untuk melakukan Selective blurring . Tapi sayangnya, filter ini 

tidak tersedia sebagai Smart Filter yang berarti Anda tidak dapat kembali dan 

mengedit pengaturan di lain waktu. 

 

 
Filters Blur baru 

Filter ini dapat anda temukan didalam menu Filter Blur>. 
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Dengan menggunakan alat Blur 

Meskipun filter ini terdaftar sebagai tiga item menu yang terpisah, namun mereka 

muncul dalam satu galeri dengan tiga alat yang berbeda. 

 

21. Menggunakan filter baru Lighting Effects  

Didalam CS5 apakah Anda mendapatkan jendela pratinjau kecil untuk filter Lighting 

Effect ? Didalam Photoshop CS6 mereka telah mangantikanya menggantinya dengan 

daerah pratinjau yang cukup besar, mereka memberika dalam CS6 ini suatu mesin 

baru yaitu Photoshop Graphics Mercury. 
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Penampilan Filter Lighting Effects  

Lighting Effect filter baru di dalam Photoshop CS6 

 

 

22. Pengisian dengan Scripted Patterns 

 

Menggunakan Fill too (Edit> Fill), Anda dapat mengisinya deangan menggunakan 

Scripted Patterns. Ini adalah 5 preset yang mengubah cara Anda mengisi pola. 

Sayangnya, kegunaannya terbatas karena mereka tidak menawarkan pilihan untuk script. 

 



 
 

Komunitas eLearning IlmuKomputer.Org 

Copyright © 2003-2013 IlmuKomputer.Org 

 
Berikan centang pada  pilihan Scripted Patterns untuk mengakses Scripted Patterns 

 

 
Mengisi 5 scripted pattern  

 

23. Menggunakan kelompok groups layers 
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Sebelumnya, untuk menerapkan masker kliping dan gaya layer untuk kelompok, Anda 

harus mengubah kelompok menjadi sebuah Smart Object. Sekarang Anda dapat 

melakukan ini di CS6 tanpa harus mengubah kelompok menjadi sebuah Smart Object. 

 

 
Manfaatkan fitur baru ini untuk mengorganisir layer Anda untuk lebih efisien. 

 

 

24. Bekerja dengan  Shape Layers baru 

 

Dalam Photoshop CS5, Shape Layers hanya memberikan penyesuaian lapisan warna 

solid dengan jalur vektor. Dalam Photoshop CS6, lapisan vektor sekarang membentuk 

Shape Layers  dan mereka memberikan kepada Anda untuk dapat mengisi dan 

memberikan kejutan seperti apa yang akan Anda temukan jika Anda menggunakan 

Adobe Illustrator. Anda juga dapat memiliki beberapa bentuk vektor dalam satu lapisan 

vektor dan menyelaraskannya, mengatur ulang, dan bahkan mengubah/mengedit (Edit> 

Transform) bentuk shape tersebut. 
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Anda dapat mengatur mengisi atau memberikan stroke dalam mode transparant, warna 

solid, gradasi, ataupun dalam mode pattern. 

 
 

3 stroke presets standar yang memungkinkan Anda untuk membuat garis putus-putus 

dengan cepat 
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Anda bahkan dapat membuat  kustom Anda sendiri dengan mengklik tombol "More 

Options". 

 

25. Mengedit video dalam panel Timeline 

 

Apa benar ada Video editing di dalam Photoshop? informasi ini benar dan bagi Anda ini 

adalah sesuatu yg luar biasa CS6 ini mampu video dalam standart DSLR! Sekarang Anda 

dapat mengimpor video sebagai Smart Objects dan mengeditnya menggunakan panel 

Timeline. Panel ini dapat bekerja seperti yang ditemukan didalam Adobe Premiere. Fitur 

Video baru ini sekalipun mempunyai kemampuan pengeditan namun tidak 

menggantikan Adobe Premiere sebagai sofware video editing, tapi tidak dapat 

dipungkiri baha Anda sebenarnya sangat membutuhkannya. disini Anda dapat 

mengatur klip, menerapkan transisi, dan bahkan memberikan efek Photoshop. 

 

 

Perhatikan bahwa Photoshop tidak pernah dapat menyimpan video ke PSD. Sebaliknya, 

jika Anda mengirim file ke orang lain, Anda harus mengirim mereka file dalam bentuk 

video juga. 
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Tracks ngelink ke layers. 
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Dalam beberapa hal, video editing di Photoshop memang lebih mudah 

dibanding  Adobe Premiere. 

 

 

27. Membuat Non-Destructive Jenis 3D  

 

Mari kita Kembali ke Photoshop CS5, Apabila Anda ingin mengubah teks ke dalam teks 

2D 3D, Anda akan menggunakan Repousse tool(3D> repousse> Edit repousse) yang 

cukup mudah digunakan. jika Anda mengetikan sesuatu yang salah, Anda tidak dapat 

memperbaikinya tanpa melepas segalanya. Dalam Photoshop CS6, alat repousse 

dihilangkan dan diganti dengan palet Properties (Properties palette ini sama dengan 

yang Anda gunakan untuk mengedit adjustment layers)). 

 

Proses untuk mengedit objek 3D di Photoshop 
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Dengan Obyek 3D Teks yang dipilih, Properties panel (Window> Properties) akan 

menampilkan semua fitur yang dapat Anda temukan di alat repousse Photoshop CS5 ini. 

Untuk mengubah teks 3D Anda, klik pada tombol Sumber Edit pada tab Mesh. 

 

Referensi : 

http://adobephotoshop-cs.blogspot.com 

http://ilmuphotoshop.com/ 

http://ilmugrafis.com 
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